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Creating a ModusToolbox™ 3.x BSP

About this document
Scope and purpose

This application note describes how to create a Board Support Package (BSP) using the ModusToolbox™ BSP
Assistant tool. This document explains the basics of a BSP along with the various use cases where the BSP
Assistant tool can be useful during application development using ModusToolbox™ version 3.1 or above.

Note: Applications developed with ModusToolbox™ version 3.0 or above are not backward compatible with
earlier versions of ModusToolbox™.

Intended audience

This document is intended for anyone who needs to create a user-specific design board using an Infineon
device supported inside the ModusToolbox™ ecosystem.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus
and sub-menus.

Italics Denotes file names and paths.

Courier New Denotes APlIs, functions, interrupt handlers, events,
data types, error handlers, file names, directories,
command line inputs, code snippets, etc.

File > New Indicates that a cascading sub-menu opens when you
select a menu item.

Abbreviations and definitions

Abbreviation Meaning

BSP Board support package
MCU Microcontroller unit

MPN Manufacturer part number
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1 Introduction

1 Introduction

1.1 What is a BSP?

BSPs are a set of files and directories that provide the necessary functionality to develop target applications
on any given board. The board is typically a printed circuit board (PCB) used in any electronics product like

a mobile phone, laptop, digital camera, etc. These boards usually have a microcontroller (or microprocessor)
chip with various peripherals and other components that are wired together to meet the target application
requirements.

Infineon has a range of microcontroller devices belonging to various families such as PSoC™ 4, PSoC™ 6,

and XMC™, and provides development kits (or boards) for the evaluation of these devices. The BSPs for

these development boards are made available through the ModusToolbox™ ecosystem in the Infineon GitHub
website.

1.2 BSP Assistant overview

The BSP Assistant tool helps you create and manage custom BSPs for the board designed for your application
using Infineon MCUs. The tool is available in both graphical user interface (GUI) and command line interface
(CLI) versions.

Q C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10 — O .
File Edit Settings View Help

B5P location: | C:/Users/Public/Example/TARGET_MyBSP
MName Update Available Remove
Devices
* Configurations
Device Configurator 410
Smart I/0 Configurator 4.10
~ Libraries
catlemlp x
core-lib >~
core-make Py
mtb-hal-catl > _ _ _
mtb-pdl-cat1 ) Please select a leaf node in the tree to see its properties.
recipe-make-catla x
Components
Defines
Add Configuration...| | Add Library...
= F
Finding MCUs compatible with this BSP... "
mtb-template-cat1 asset found at C:/Users/follettc)/.modustoolbox/global/mtb-template-cat1/release-v1.0.0 (6 ms)
mtb-pdl-catl asset found at C:/Users/follettcj/. modustoolbox/global/mtb-pdl-catl/release-v3.3.1 (1 ms)
MCUs compatible with this BSP found (7 ms) v

Save Close

Figure 1 BSP Assistant GUI
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1 Introduction

1.3 Overview

This application note has the following sections to help you learn the following:
«  BSP design - Explains the BSP architecture

« Using the BSP Assistant tool - Explains typical BSP Assistant tool use cases such as creating and
modifying BSPs using the Hello World code example

+ Advanced usage - Explains advanced BSP Assistant tool use cases like BSP migration between generations

1.4 Software requirement

Software Minimum required version

ModusToolbox™ 3.1
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2 BSP design

2 BSP design

As mentioned previously, a BSP is a set of files and directories with content specific to a target board that
enables you to develop a target application. BSPs for evaluation boards of MCUs supported by ModusToolbox™
are made available through the ModusToolbox™ ecosystem via Infineon GitHub repositories.

2.1 Software

Software is provided in source or library form and contains a set of APIs to control and configure the
microcontroller and other onboard components. A BSP specifies software that it requires as dependencies.
For Infineon BSPs provided on GitHub, dependencies are specified in a manifest file. Once a BSP is created by
the user, (either during application creation or by using the BSP Assistant) the dependencies are specified in a
set of *.mtbx files in the BSP's deps subdirectory. These dependency files contain information for downloading
the minimum set of libraries required to develop an application on the given board.

2.1.1 Peripheral Driver Library (PDL)

PDL contains a set of low-level APIs to control hardware peripherals such as UART and SPI. The interfaces are
usually specific to a particular microcontroller or microcontroller family. For some MCU families, the low-level
API library may use an alternative name for the low-level library APIs other than PDL mentioned in this section.

2.1.2 Hardware Abstraction Layer (HAL)

HAL contains a set of high-level APIs to control hardware peripherals; the interfaces are more portable than PDL
in case of the following changes:

+  Changing the pin assignments for the peripherals within the same microcontroller

+  Porting to another microcontroller within the same family

+  Porting to another microcontroller in a different family

2.1.3 Other libraries

These libraries provide the following functionality:

«  Abstraction libraries: These typically abstract the RTOS to help in porting the application across different
RTOS like FreeRTOS or to a different board.

« Base libraries: These libraries, such as core-lib, core-make, recipe-make are necessary for the build
process.

+ Board utilities libraries: These are libraries supporting various utilities available on the board other than
the microcontroller, such as sensors and displays, and are used to control them.

« MCU Middleware: These include middleware that provides RTOS services, such as FreeRTOS, or peripheral
services, such as capacitive sensing.

2.2 Documentation

BSPs have the following documentation accompanying them:

+ Docs/api_reference_manual.html: Provides details of the APIs, structures, and macros that are provided
as part of the BSP and details of the board design, including the available microcontroller, LEDs, buttons,
memory, and sensors.

«  README.md: Provides top-level information about the BSP and usually contains links to additional
documentation.

+  RELEASE.md: Provides information about various versions of the BSP and changes from one version to
another.

Application note 5 002-35297 Rev. *A
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2.3 Typical BSP contents

v (= bsps
v (= TARGET_APP_CYSCPROTO-062-4343W
v (= bluetooth
[ cybsp_bt_config.c
h| cybsp_bt_config.h
v (= COMPONENT_CMOP
v (= TOOLCHAIN_A Clang
|§] startup_psoc6_02_cm0Oplus.S
v (= TOOLCHAIN_ARM

|S| startup_psocB_02_cmOplus.s

@g linker.sct

v (= TOOLCHAIN_GCC_ARM
|§] startup_psoc6_02_cmOplus.S
=| linker.ld

v (= TOOLCHAIN_IAR
[§] startup_psoc6_02_cmOplus.s
= linker.icf
£ system_psoch_cmOplus.c
v (= COMPONENT_CM4

v (= TOOLCHAIN_A Clang

v (= deps

v (= COMPONENT_CM4

v (= TOOLCHAIN_A_Clang
|8 startup_psocb_02_cm4.S

v (= TOOLCHAIN_ARM
[§] startup_psoc6_02_cmd.s
{55 linker.sct

v (= TOOLCHAIN_GCC_ARM
S startup_psoc6 02_cmd4.S
= linker.ld

v (@ TOOLCHAIN_IAR
[§] startup_psoc6_02_cmd.s
= linker.icf

[ system_psoch_cmd.c

v (= config

= GeneratedSource

Q design.cycapsense
E design.cyqgspi
E design.modus

= catlemOp.mtbx
=| core-lib.mtbx
=| core-make.mthbx

= wth_-hal.rat1 mthe

v (= docs

=| core-lib.mtbx

=| core-make.mtbx

= mtb-hal-catl.mtbx

= mtb-pdl-catl.mtbx

=| recipe-make-catla.mtbx

= html
@ api_reference_manual.html
[h] cybsp_doc.h
[ cybsp_hw_config.h
[n] cybsp_typesh
[ cybsp.c
lh] cybsp.h
|| system_psocb.h
@ bsp.mk
i cyreservedresources,pl2
= cyreservedresources.p
Z| cyreservedresources,p9
= EULA
=| LICENSE
props.json
[w] README.md
|w] RELEASE.md

Figure 2 BSP contents

2.3.1 Startup code and linker files

Startup code is usually in assembly format and is the code that executes after a CPU reset. These are usually
specific to a CPU and configure various microcontroller special-function registers such as the stack pointer.

Linker files are used to map various sections of the compiled source code into memory regions like flash and
SRAM. These are used by the build system to generate the final binary that is programmed onto the target.

Both startup code and linker files are specific to a build environment like GCC. BSPs that accompany the
ModusToolbox™ ecosystem provides these items for the GCC, IAR, and Arm® build environments.

Since the startup code and linker files are CPU and toolchain dependent, they are located inside cOMPONENT and
TOOLCHAIN directories inside the BSP, which allows them to be included conditionally. For example, the directory
COMPONENT_CM4/TOOLCHAIN_GCC_ARM would contain startup code and linker script files that are only used when

building a project for the CM4 CPU with the Gcc_arM toolchain.

2.3.2 Configuration files

ModusToolbox™ comes with various BSP configurator tools that enable you to configure the microcontroller
peripherals. Typically, these configure the clock, pin, and other resource-related settings in the microcontroller.
There are GUI tools like the Device Configurator to open/edit the configuration files, which are saved in XML
format with a specific file extension like design.modus. When the configuration is saved, the tool generates the
configuration code that is linked together with the application code during the build process.

The files for each BSP configurator are located in the config directory inside the BSP.

The following table summarizes the available BSP configurator tools, associated configuration file, and a brief

description.
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Table 1

BSP configuration files

Configurator tool name

Configuration file
extension

Description

capsense-configurator

*.cycapsense

CAPSENSE™ Configurator is used to create and configure
CAPSENSE™ widgets, and generate code to control the
application firmware.

device-configurator *.modus Device Configurator is used to enable and configure device
peripherals, such as clocks and pins, as well as standard
MCU peripherals that do not require their own tool.

gspi-configurator *.cyqgspi The QSPI Configurator is used to open or create

*.cymem configuration files, configure memory slots, and generate

code for your application when external flash devices are
connected to the MCU using a Quad Serial Peripheral
Interface (QSPI).

seglcd-configurator *.cyseglcd SegLCD Configurator is used to generate display structures
for the SegLCD Driver.

smartio-configurator *.modus Smart 1/0 Configurator is used to configure the smart I/O
pins in the MCU.

usbdev-configurator *.cyusbdev Universal Serial Bus(USB) configurator is used to configure

USB device descriptors.

2.3.3

Generated source files

BSP Configurators generate related source/header files in the Generatedsource subdirectory that are then
included as part of the application build. This helps avoid writing lengthy configuration code.
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v (= GeneratedSource

cycfg_capsense.c
cycfg_capsense.h
cycfg_clocks.c
cycfg_clocks.h
cycfg_connectivity_bt.c
cycfg_connectivity_bt.h
cycfg_notices.h
cycfg_peripherals.c
cycfg_peripherals.h
cycfg_pins.c
cycfg_pins.h
cycfg_gspi_memslot.c
cycfg_gspi_memslot.h

RPEREBREEREBREREE

=

[

cycfg_routing.c
cycfg_routing.h
cycfg_system.c
cycfg_system.h
cycfg.c

cycfg.h

=| cycfg.timestamp
| gspi_config.cfg

ERERE

lh| cycfg_capsense_defines.h
cycfg_capsense_tuner_regmap.h

Figure 3 Sample Generatedsource subdirectory

2.3.4 Static source files

A BSP contains static source files with initialization routines for the board. These must be called by the
application code before using any MCU peripherals. Typical BSP static source files that are included with

ModusToolbox™ BSPs are as follows:

+  cybsp.c- Provides initialization code for starting up the hardware contained on the Infineon board

«  cybsp.h- APl header file for cybsp.c

+  cybsp_doc.h - Contains code for generating BSP html documentation

+  cybsp_types.h- Contains code for the states of button/pin/led on the Infineon board

«  bluetooth/cybsp_bt_config.c - Provides initialization settings for the Bluetooth® module
*  bluetooth/cybsp_bt_config.h - APl header file for cybsp_bt_config.c

2.3.5 Documentation files

A BSP contains Doxygen/markup-based documentation for the application developer with the details of various

libraries, release notes, etc.
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3 Using the BSP Assistant tool

This section describes two basic use cases for working with the BSP Assistant tool:
« Creating a new BSP
«  Customizing an existing BSP

These use cases show the tools in a Windows operating system, as well as using the Eclipse IDE. If you use
another IDE/OS combination, the steps will be similar but may not be identical.

3.1 Creating a new BSP

Use this workflow to create a new BSP for the Infineon MCU board. You can create the BSP using an existing
BSP as a starting point and then modify it for your needs, or you can create a BSP from scratch based on the
devices the board contains. For demonstration, this workflow considers creating a BSP for a board based on the
CY8C6347BZI-BLD44 MCU device. Each method is described in the following sections.

3.1.1
1.

Create and configure the BSP using the existing sample board

Type bsp-assistant in the Windows search tool to open the BSP Assistant tool or look in the Window's
menu under "ModusToolbox <version>",

2. After the tool loads, select File > New > From Sample Board to open the Create New BSP From Sample
Board window.
Create New BSP From Sample Board - BSP Assistant 1.10 X
Source Template
Enter filter text... Browse for BSP...| [|—| ll+| | PSOC6-GENERIC «
Kit Name MCU/50C/SIP " | This board support package is
CYW9P6251-43438EVB-01 AW-CU427 (CY8C62478 | Intended for creating custom PSoC™ 6
BSPs.
EVAL-XMC4800PSOCEM5-PSOCE CY8CE24ABZI-S2D44 *
KIT-BGT60TR13C-EMBEDD CY8C6247FDI-DO2 Kit Features:
| PSOC6-GENERIC CY8C6347BZI-BLD53 | o _
- ® This is a generic template,
TR_AVEO BSPS_ v there is no corresponding
< i h > physical board and henceno  «
Destination
Parent directory: ‘C:/Users/Pub\ic/Examp\e ‘ Browse...
New BSP name: TARGET_ ‘MyBSPl
o | e
Figure 4 Create New BSP dialog
3. Select PSOC6-GENERIC under the PSoC™ 6 BSPs category or if the board you are creating is similar to an
existing Infineon board, you can select it as the starting BSP.
4, Set the directory path where the BSP will be created in the Parent Directory text box.
5. Type a suitable name for the BSP in the New BSP name: TARGET_ text box. This example uses the name
MyBSP.
6. Click OK.

The BSP Assistant tool starts downloading the contents from the Infineon GitHub website; when
finished, the screen should look like the following:
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[ C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1,10 - ] X
File Edit Settings View Help
BSP location: | C:/Users/Public/Example/TARGET_MyBSP |
Mame Update Available | Remove || 1y 50 /51e; | cvece3a78z1-BLDS3 |
Devices
v Configurations o Device Info: Open CYBCH347B71-BLD33 Documentation
Device Canfigurator 4.10 _ Connectivity module: | Mone
Smart I/0 Configurator 4,10 |
~ Libraries
catlemdp x CMO+ pre-built firmware image: | This image starts CM4 core at CY_CORTEX ~
core-lib X Using HAL interface: CY_USING_HAL -
core-make x
mth-hal-cat1 x
mitb-pdl-catl A
recipe-make-catla x
Coemponents
Defines
Add Configuration...  Add Library...
T F
Finding MCUs compatible with this BSP... “
mitb-template-cat] asset found at C:/Users/follettcj/.modustoolbox/global/mth-template-cat1/release-v1.0.0 (& ms)
mtb-pdl-cat] asset found at C:/Users/follettc)/.modustoolbox/global/mtb-pdl-catl/release-v3.3.1 (1 ms)
MCUs compatible with this BSP found (7 ms) v
Save Close
Ready
Figure 5 BSP Assistant finished loading content

7. Change the MCU device to CY8C6347BZI-BLD44 by selecting it from the MCU/SOC/SIP drop-down menu
under the Devices section as shown and click Save.

Note: You can start typing the MCU name in the drop-down box to filter the choices.

C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10 X
File Edit Settings View Help
BSP location: |C:/Users/Public/Example/TARGET_MyBSP
Name Update Available  Remove || )\ ; /s, CY8C6347BZI-BLDA4 v
Devices ] CY8C6347BZI-BLD33
v Configurations @ Device Info: CY8C6347BZI-BLD34
Device Configurator 4.10 | CY8C6347BZI-BLD43

Connectivity module: CYBCE347R] BlDAd
CY8C6347BZI-BLD53
CMO+ pre-built firmwg CY8C6347BZI-BLD54

Smart /O Configurator 4.10
v Libraries

catlcmOp
core-lib

Using HAL interface: CY_USING_HAL 4
core-make
mtb-hal-cat1
mtb-pdl-cat1
recipe-make-catia

D 9.0 9

Components

Defines

Add Configuration... ' Add Library...

Y VST SO PGS WIS TS Do
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (9 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (4 ms)

MCUs compatible with this BSP found (13 ms)

Save Close

Ready

Figure 6 Changing MCU device

Messages appear in the output console ending with Saving changes to BSP succeeded. as follows:
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C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10
File Edit Settings View Help

BSP location: |C:/Users/Public/Example/TARGET_MyBSP

Name Update Available Remove
Devices
v Configurations ﬂ Device Info: Open CY8C6347BZI-BLD44 Documentation
Device Configurator 4.10
Smart I/O Configurator 4.10
v Libraries

MCU/SOC/SIP: CY8C6347BZI-BLD44| v

- Connectivity module: None

CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~
catlcmOp

core-lib
core-make
mtb-hal-cat1
mtb-pdI-cat1
recipe-make-catia

Using HAL interface: CY_USING_HAL i

KEHAANK

Components

Defines

Add Configuration... ' Add Library...

TEISUSE VoYl PO ST ST UEVINE © T U U DA DT TUTeS

Saving changes to BSP succeeded.

Save Close

Ready

Figure 7 Output console messages

8. Under the Configurations section, click Device Configurator 4.10, and then click the Edit
Configuration button to open the Device Configurator tool.

Q Ci/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10 - [m} X
File Edit Settings View Help

BSP location: |C:/Users/Public/Example/TARGET_MyBSP ‘

Mame Update Available Remove

Devices

~ Configurations
m—De\n(e Configurator 4.10
mart /U Configurator 4.10

~ Libraries
catlemOp
core-lib
core-make

Location: |C Users/Public/Example/TARGET_MyBSP/config/design.modus |

Modify: I Edit Configuration |
O Help: Open Device Configurator 4.10 Decumentation

L

L

emwin
mtb-hal-cat1
mitb-pdl-catl
recipe-make-catla

HEAAAN

Components
Defines

Add Configuration... |Add Library...

device-db asset found at C:/Users/follettej/ . modustoolbox/global/device-db/release-v4.2.0 (6302 ms) ”
Loading data from device-db...
Data loaded from device-db (4380 ms)
Loading BSP...
Finding the mth-template-cat1 (release-v1.0.0) asset...
Finding the mth-pdl-cat? asset...
Finding MCUs compatible with this BSP...
mth-template-cat1 asset found at C:/Users/follettc)/.modustoolbox/global /mtb-template-cat1/release-v1.0.0 (6 ms)
mtb-pdl-catl asset found at C:/Users/follettcj/.modustoolbox/global/mtb-pdl-cat1/release-v3.3.1 (1 ms)
MCUs compatible with this BSP found (10 ms) v
Save Close
Figure 8 Opening Configurator from BSP Assistant
9. For this demo, make the following changes:
«  Name the pin P5[0] as CYBSP_DEBUG_UART_RX from the Pins tab.
«  Name the pin P5[1] as CYBSP_DEBUG_UART_TX from the Pins tab.
«  Name the pin P13[7] as CYBSP_USER_LED from the Pins tab.
« Disable cLk_ALT_sys_T1ck from the System tab, System Clocks > Miscellaneous.
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Ready

C:/Users/Public/Example/TARGET_MyBSP/config/design.modus* - Device Configurator 4.10 - X
File Edit Settings View Help
= P Y
J I E e ) (
CY8C6347BZI-BLD44 P5[1] (CYBSP_DEBUG_UART_TX) - Parameters g X
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA ‘Enter filter text... 19 B
‘Enter filter text... Fe ‘\f = 4 lg L{ ! 5“2 Name Value ~
Resource Name(s) Personality 2o e v OverYiew
Port 0 0098 i (2) Configuration Help  Open GPIO Documentation
Port 1 000 v General
v Port5 "000: (7) Drive Mode Analog High-Z. Input buffer off
P5[0] |CYBSP_DEBUG_UART RX | Pin 3.0 --4-4 7) Initial Drive State High (1) v
P5[1] |CYBSP_DEBUG_UART_TX| Pin-3.0 00 v Input
0 P5[2] [ioss 0_port 5 pin_2 S : (7) Threshold CMOS v
O P5[3] |ioss 0_port 5 pin_3 ol 2) Interrupt Trigger Type None ~
[ P5[4] |ioss 0_port 5 pin_4 T v Output
O P5[5] |ioss_0_port_5_pin_5 (2) Slew Rate Fast .
M neis A - . - Vi« D P5[1] (CYBSP_DEBUG_UART_TX) - Parameters  Code Preview
Notice List g X
00 Errors I 0 Warnings [ZJ 0 Tasks 00 Infos
Fix Description Location
Ready
Figure 9 Changing pin settings 1
C:/Users/Public/Example/TARGET_MyBSP/config/design.modus* - Device Configurator 4.10 - X
File Edit Settings View Help
=1 f
=HD
CY8C6347BZI-BLD44 P13[7] (CYBSP_USER_LED) - Parameters g X
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA ‘Enter filter text... 19 B
‘Enterﬁ\ter(extm Z\F B 4 lg ‘{ S x Name Value .
Resource Name(s) Personality Mlllccoo000005 v Over\fiew
O P13(0] |ioss_0_port_13_pin_0 - (Z) Configuration Help  Open GPIO Documentation
O p13[1] ioss_0_port_13_pin_1 A Gen?ral . .
0 P13(2] [i0ss 0_port 13 pin 2 ! Drive Mode Analog High-Z. Input buffer off -
(2} Initial Drive State High (1 2
O P13[3] |ioss_0_port_13_pin_3 = igh (1)
v Input
O P13[4] |ioss_0_port_13_pin_4
(2) Threshold CMOS v
O P13[5] |ioss_0_port_13_pin_5 p i
- (2 Interrupt Trigger Type | None ¥
[ P13[6] |ioss 0 port 13 pin 6 S
- v Output
| P13[7] | CYBSP_USER_LED Pin-3.0 | (3) Slew Rate — 7.
Port 14 vll< 5 N
P13[7] (CYBSP_USER _LED) - Parameters Code Preview
Notice List g X
00 Errors I 0 Warnings H 0 Tasks 00 Infos
Fix Description Location

Application note

Figure 10 Changing pin settings 2
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C:/Users/Public/Example/TARGET_MyBSP/config/design.modus - Device Configurator 4.10

v Miscellaneous

[J CLK_ALT_SYS_TICK

srss_0_clock_0_altsystickclk 0

- X

File Edit Settings View Help

“HO
CY8C63478Z1.228 CLK_ALT_SYS_TICK - Parameters [DISABLED] 8 x
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA ‘Enterﬂ ter text Feal =
Enter filter text. IV B ® ‘% [ 28 Name Value
Resource Name(s) ~ v OverYiew

FLL+PLL (7) Configuration Help Open SysTick Documenta

High Frequency .

Input

CLK_BAK srss_0_clock_0_bakclk 0

CLK_LF srss_0_clock_0_Ifclk_0 o

[] CLK_PUMP srss_0_clock_0_pumpclk_0

CLK_TIMER srss_0_clock 0_timerclk 0 |y < >
< > CLK_ALT_SYS_TICK - Parameters [DISA... Code Pr...
Notice List g X
00 Errors I 0 Warnings H 0 Tasks 00 Infos

Fix Description Location

Ready
Figure 11 Changing clock settings
10. Click File > Update All Personalities and then click File > Save.
11.  Close the Device Configurator tool.
12.

On the BSP Assistant tool, under the Libraries section, check that the BSP includes the following
dependent libraries that will be used for an application:

. catlcmOp

. core-1lib

. core-make

. mtb-hal-catl
. mtb-pdl-catl

. receipe-make-catla

Application note
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[ C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1,10 - ] X
File Edit Settings View Help
BSP location: | C:/Users/Public/Example/TARGET_MyBSP
Name Update Available Remove
Devices
~ Configurations
Device Configurator 4,10 =
Smart I/0 Configurator 4,10 |
~ Libraries
catlemip x
core-lib x
core-make x
mitb-hal-cat1 x X i X
mitb-pdl-catl a Please select a leaf node in the tree to see its properties,
recipe-make-catla x
Coemponents
Defines
Add Configuration...  Add Library...
= 7 d T El it i o T F
props.json --set-device CYBOB447BZ|-D34 --force” “
Saving changes to BSP succeeded. W
Save Close
Ready
Figure 12 Checking libraries

13. If you need any additional Libraries other than those listed above, click Add Library button to view the
list of available libraries. For example, the following image shows adding the emwin package.

Note: Ifyou click the filter button, only enabled dependencies will be listed.
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[ C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1,10 - ] X
File Edit Settings View Help
BSP location: | ers/Public/Example/TARGET_MyBSP
Name Update Available Remove
Devices
~ Configurations
Device Configurator 4,10 )
Smart I/0 Configurator 4,10 g
~ Libraries
catlemip x
core-lib x
core-make x
mitb-hal-cat1 x X i X
mth-pdi-catl & Please select a leaf node in the tree to see its properties,
|
recipe-make-catla x
Components
Defines
Add Configuration... | Add Library... |
T 7 T ] PP T ] F
propsjson --set-device CYBOB44TBZI-D34 --force” G
Saving changes to BSP succeeded. v
Save Close
Ready
Add libraries - BSP Assistant 1.10 X
EMW VAR 4= emwin
Name Shared Version SEGGER emWin
v Middleware embedded graphic
. library and graphical
v . N ‘
M emwin ] Latest 6.X release user interface (GUI)
framework.
. . " PN T] . . .
Figure 13 Adding "emwin" to the list of libraries

14.  After the necessary libraries are added, click the Save button to save the BSP.
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[ C/Users/Public/Example/ TARGET_MyBSP - BSP Assistant 1.10

File Edit Settings View Help
BSP location: |C:/Users/Public/Example/TARGET_MyBSP

Name Update Available Remove .
v Configurations
Device Configurator 4.10
Smart 1/O Configurator 4.10
v Libraries

catlcmOp
core-lib
core-make
mtb-hal-cat1
mtb-pdl-cat1
recipe-make-catia

DA AN

[ emwin

Components

Defines

Add Configuration... ' Add Library...

Please select a leaf node in the tree to see its properties.

[INFO] settingsFileName= "C:/Users/palaniswamy/AppData/Local/Infineon_Technologies_ AG/ModusToolbox/Device Configurator.ini*

Ready

Save Close

Figure 14 Saving the updated BSP

Otherwise, there will be a warning as shown when you exit the tool.

k4 BSP Assistant 1.10 e

| You have pending changes that have not been saved.
Do you really want to exit without saving them?

¥es HNo

Figure 15 BSP saving missed warning

This completes the BSP creation; you can exit the tool now. If you changed any libraries, you might see
the following warning while leaving the tool; you can ignore the warning since the BSP is not yet being

used in any applications:

BSP Assistant 1.10 «
| The libraries are modified. They must be updated in any applications that use

this BSP either by using the Update feature of the Library manager or by
running make getlibs.

Figure 16 Warning can be ignored
3.1.2 Create and configure the BSP using MPN

1. Type bsp-assistant in the Windows search tool to open the BSP Assistant tool or look in the Windows

menu under "ModusToolbox <version>".
2.

Application note 16

After the tool loads, select File > New > From Contained MPNs to open the Create New BSP window.
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Create New BSP From Contained MPNs - BSP Assistant 1.10 X

CY8C6347BZI-BLD44 4| |=

MCU/SQC/SIP: Companion:

v PSoC™ 6 MCUs | None |

CY8C6347BZ1-BLD44

Destination

Parent directory: ‘C:/Users/Pub\ic/ExamplefM PN ‘ Browse...

New BSP name: TARGET_ | MyBSP)

Figure 17 Create New BSP window

3. Enter the first few characters of the MPN CY8C6347BZI-BLD44 in the search bar and select the MPN
CY8C6347BZI-BLD44 in the pane MCU/SOC/SIP from the results.

4, Select None in the Companion paneas the BSP we create in the example does not have any connectivity
device connected to the MCU.

5. Set the directory path where the BSP will be created in the Parent Directory text box.

6. Type a suitable name for the BSP in the New BSP name: TARGET_ text box. This example uses the name
MyBSP.

7. Click OK.
The BSP Assistant tool starts downloading the contents from the Infineon GitHub website; when
finished, the screen should look like the following. Ignore any warnings in the bottom pane at this
stage, as it will be fixed in the following steps.

Application note 17 002-35297 Rev. *A
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[£ C/Users/Public/Example_MPN/TARGET_MyBSP - BSP Assistant 1.10 —
File Edit Settings View Help

BSP location: |C:/Users/Public/Example_MPN/TARGET_MyBSP

Name Update Available Remove
Devices
v Configurations ﬂ Device Info: Open CY8C6347BZI-BLD44 Documentation
Device Configurator 4.10 |
Smart I/O Configurator 4.10
v Libraries

MCU/SOC/SIP: CY8C6347BZI-BLD44 v

Connectivity module: None

CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~
catlcmOp

core-lib
core-make
mtb-hal-cat1
mtb-pdI-cat1

recine-make-cat1a

Using HAL interface: CY_USING_HAL i

X XXX

Add Configuration... ' Add Library...

global/mtb-pdi-cat1/release-v3.4.0/props json --set-device CY8Lb34/BZI-BLD44 --force”

BSP created.

Setting default values...

Saving changes...

Saving changes to BSP succeeded.

Save Close

Ready

Figure 18 BSP Assistant finished loading content

8. Select the Device Configurator 4.10 from the Configurations item in the left pane. Then click the Edit
Configuration button to update the MCU configuration to match that of the BSP created in section 3.1.1.
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Table 2

{5 C/Users/Public/Example_MPN/TARGET_MyBSP - BSP Assistant 1.10

File Edit Settings View Help

BSP location: ‘C' /Users/Public/Example_MPN/TARGET_MyBSP

Name Update Available Remove

Devices

v Configurations

,\

Smart I/O Configurator 4.10
v Libraries

catlcmOp

core-lib

core-make

emwin

mtb-hal-cat1

mth-ndl-cat1

2 AN NK

Location: ‘C /Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus

Modify: | Edit Configuration

o Help: Open Device Configurator 4.10 Documentation

Add Configuration... ' Add Library...

Loading BSP...

Finding the mtb-template-cat1 (release-v1.2.0) asset...
Finding the mtb-pdI-cat1 asset...

Finding MCUs compatible with this BSP...

mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (8 ms)

mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (2 ms)

MCUs compatible with this BSP found (15 ms)

Ready

[ C:/Users/Public/Example_MPN/TARGET_MyBSP/config/desi
File Edit Settings

=1=1E

CY8C6347BZI-BLD44

modus - Device C

View Help

Peripherals Pins  Analog-Routing System

Enter filter text

4.10

Peripheral-Clocks

Resource
Port 0
Port 1
Port 5
Port 6
Port 7
Port 8
Port 9
Port 10
Port 11
Port 12

v Daw 12

Name(s) Personality

Parameters g X

DMA

B0 s 7

Notice List

00 Errors I 0 Warnings U 0 Tasks 00 Infos

Fix Description

Ready

Parameters

Save Close

Select an enabled resource to configure it.

Code Preview

Location

Figure 19

Adding identifier to the pin

Opening the Device Configurator
9. Enable and add the name for the following pins in the Device Configurator.

Port and pin number

Name

P5[0] CYBSP_DEBUG_UART_RX
P5[1] CYBSP_DEBUG_UART_TX
P6[4] CYBSP_SWO

P6[6] CYBSP_SWDIO

P6[7] CYBSP_SWDCK

P13[7] CYBSP_USER_LED

Application note
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[ C/Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus* - Device C 410 - %
File Edit Settings View Help
fHO™
CY8C6347BZI-BLD44 P13[7] (CYBSP_USER_LED) - Parameters g X
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA Enter filter text. |8 B
‘CbeP #|F B AT KR Name Value .
Resource Name(s) Personality v Overview
v Pports () Configuration Help  Open GPIO Documentation
P5[0] |CYBSP_DEBUG_UART_RX | Pin-3.0 v General
PS[1] |CYBSP_DEBUG_UART_TX | Pin-3.0 O Bia il Analog High-Z. Input buffer off v
v Port6 (2) Initial Drive State High (1) v
P6[4] |CYBSP_SWO Pin-3.0 v Input
P6[6] |CYBSP_SWDIO Pin-3.0 () Threshold CMOs >
P6[7] |CYBSP_SWDCK Pin-3.0 (2) Interrupt Trigger Type None v
v Port 13 v Output
< > P13[7] (CYBSP_USER_LED) - Parameters Code Preview
Notice List g X
00 Errors I 0 Warnings B 0 Tasks 00 Infos
Fix Description Location
Ready
Figure 20 Adding identifier to the pin
10. Forthe pin P6[4], set the Drive Mode in the Parameter pane to Strong Drive. Input buffer off.
[ C/Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus* - Device C 410 - X
File Edit Settings View Help
“HO™
CY8C6347BZI-BLD44 P6[4] (CYBSP_SWO) - Parameters 8 x
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA Enter filter text. &9 B
‘CbeP 4T B &g FRE  Name Value "
Resource Name(s) Personality v Ovelt\(‘iew
v Port5 @ Configuration Help  Open GPIO Documentation
P5[0] |CYBSP_DEBUG_UART RX | Pin-3.0 v Gene_ral
P5[1] |CYBSP_DEBUG_UART TX| Pin-3.0 (2} Drive Mode Strong Drive. Input buffer off v
v Port6 (2} Initial Drive State High (1) v
P6[4] |CYBSP_SWO Pin-3.0 v Input
P6[6] |CYBSP_SWDIO Pin-3.0 (2) Threshold CMOs v
P6[7) |CYBSP_SWDCK Pin-3.0 2) Interrupt Trigger Type  None N
v Port 13 v Output
P13[7] | CYBSP_USER_LED Pin-3.0 (2) Slew Rate Fast Vv
< > P6[4] (CYBSP_SWO) - Parameters Code Preview
Notice List g x
00 Errors I 0 Warnings U 0 Tasks 00 Infos
Fix Description Location
Ready
o . o o o
Figure 21 Updating the pin drive mode setting
11. Update the following settings in the System > System Clocks block:
a. Enable the FLL
o
b. Set the Desired Frequency (MHz) as 48.000

Application note
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[ C/Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus* - Device C 410 - X
File Edit Settings View Help
fHO™
CY8C6347BZI-BLD44 FLL - Parameters g X
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA ‘Enter filter text 19 B
Enter filter text Z1F B & = L% R E,g Name Value ~
Resource Name(s) ~ ‘? ) Configuration Help Open FLL Documentation
v [ System Clocks srss_0_clock 0 e Gen?r‘al
v FLL+PLL ource Frequency ) 8MHz + 1%
| FLL srss_0_clock_0_fll_O | ; = L | ) Configuration Automatic =
) PATH_MUXO srss_0_clock_0_pathmux_0 1 7\" Desired Frequency (MHz) ‘48-000
(1 PATH_MUX1 srss_0_clock_0_pathmux_1 It ! ﬂ ) Multiplier (1-262143) ) 504
@) PATHMUX2  |srss 0 clock 0 pathmux_ 2 = . (2) Reference (1-8191) 5 42
[#) PATH_MUX3 srss_0_clock_0_pathmux_3 o ) Lock Tolerance (0-511) (5} 10
¥ PATH_MUX4 srss_0_clock_0_pathmux_4 prlicmalliiequency ) Bl 2R
o e A Alasl A Al v e
< 2 FLL - Parameters ~ Code Preview
Notice List g X
00 Errors I 0 Warnings B 0 Tasks 00 Infos
B Fix Description Location
Ready
Figure 22 Updating the FLL settings
12. Update the following settings in the System > System Clocks block:
a. Enable the PLL
b. Set the Desired Frequency (MHz) as 144.000
[ C/Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus* - Device C 410 X
File Edit Settings View Help
fHO™
CY8C6347BZI-BLD44 PLL - Parameters g X
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA ‘Enter filter text 19 B
Enter filter text Z1F B ] & 2 Name Value .
Resource Name(s) ~ (2) Source Frequency %) 8MHz £ 1%
i¥] PATH_MUX0 srss_0_clock_0_pathmux_0 Low Frequt.ency Mode [ .
] PATH_MUX1 srss_0_clock_0_pathmux_1 _ ) Configuration Automatic =
1 PATH_MUX2 srss_0_clock_0_pathmux_2 ;:—‘ = -i“:'i b Resiiedibequencyl(illiz) ‘144‘000 ||
() PATH_MUX3 srss_0_clock_0_pathmux_3 b ’ CSptinistion MinlFower .
[#1 PATH MUX4 __|srss O clock 0 pathmux 4 [ : () Feedback (22-112) 0 36
PLL srss_0_clock_0_pll_0 = e - A Referencel(ig1s) ‘T:‘ !
High Frequency : Output (2-16) 02
Input () Actual Frequency %) 144 MHz + 1%
v Miscellaneous v e
< 2 PLL - Parameters ~ Code Preview
Notice List g X
00 Errors I 0 Warnings B 0 Tasks 00 Infos
B Fix Description Location
Ready
Figure 23 Updating the PLL settings
13. Onthe System > System Clocks > High Frequency block, update the following settings:
a. Set the Source Clock for CLK_HFO0 as CLK_PATH1
b. Set the Divider for CLK_PERI as 2
14. Onthe System > System Clocks > Miscellaneous block, update the following settings:

Application note

Enable the CLK_TIMER
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15. Onthe Peripheral-Clocks tab, update the following settings:
a. Update the name for 8 bit > 8 bit Divider 7 as CYBSP_TRACE_CLK_DIV
b. Enable the 16 bit > 16 bit Divider 15 clock
[ C/Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus* - Device Confi 410 - X
File Edit Settings View Help
=]
= el
CY8C6347BZI-BLD44 16 bit Divider 15 - Parameters g x
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA Enter filter text. Z1a B
‘Enter filter text... & f B E & g Name Value
Resource Name(s) Personality ~ v Over\(lew
[ 8 bit Divider 0 W (2) Configuration Help Open Peripherals Clock Dividers Documentation
(] 8 bit Divider 1 | peri 0 div 8 1 v General
[ 8 bit Divider 2 W ?7) Source Clock %) CLK_PERI (72 MHz £ 1%)
[J 8 bit Divider 3 |peri 0 div 8 3 ‘L o
[ 8 bit Divider4 | peri 0 div 8 4 72 Mz = 1%
[J 8 bit Divider 5 | peri 0 div.8 5 start on Reset
[ 8 bit Divider 6 | peri_0_div 8.6 (2) Peripherals <unassigned>
8 bit Divider 7 |CYBSP_TRACE_CLK DIV | Peripheral Clock-3.0
~ MGIbiE hd 16 bit Divider 15 - Parameters Code Preview
Notice List g X
00 Errors I 0 Warnings EJ 0 Tasks 00 Infos
) Fix Description Location
Ready
[ C/Users/Public/Example_MPN/TARGET_MyBSP/config/design.modus* - Device Confi 410 - X
File Edit Settings View Help
=]
= el
CY8C6347BZI-BLD44 16 bit Divider 15 - Parameters g x
Peripherals Pins Analog-Routing System Peripheral-Clocks DMA Enter filter text. g B
‘Enter filter text... & f B E 4 g Name Value
Resource Name(s) Personality ~ v Over\(lew
[ 16 bit Divider 9 W (2) Configuration Help Open Peripherals Clock Dividers Documentation
[] 16 bit Divider 10 | peri 0 div_16 10 v General
[ 16 bit Divider 11 W (2) Source Clock %) CLK_PERI (72 MHz + 1%)
[J 16 bit Divider 12| peri 0 div_16_12 Divider “«4 o
[ 16 bit Divider 13 |peri 0 div 16 13 = Frequency = BlLBES ke
A o ] ?) Start on Reset
[J 16 bit Divider 14 | peri 0 div_16_14
16 bit Divider 15 | peri 0 div_16_15 Peripheral Clock-3.0 (2) Peripherals <unassigned>
16.5 bit
24.5 bit
hd 16 bit Divider 15 - Parameters Code Preview
Notice List g X
00 Errors I 0 Warnings EJ 0 Tasks 00 Infos
) Fix Description Location
Ready
Figure 24 Updating the Clock Dividers
16. Onthe System > Debug tab, update the following settings:
a. Enable Trace Mode-Serial setting
b. Set the Trace Clock>Clock as 8-bit Divider 7 clk(CYBSP_TRACE_CLK_DIV) [USED]
c. Set the Trace Pins>SWO as P6[4] digital_out(CYBSP_SWO)[USED]
17. Click File > Update All Personalities and then click File > Save.
18. Close the Device Configurator tool.
19. Ifyou need any additional Libraries other than those listed above, click the Add Library button to view

Application note

the list of available libraries. For example, the following image shows adding the emwin package.
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C:/Users/Public/Example_MPN/TARGET_MyBSP - BSP Assistant 1.10

- X
File Edit Settings View Help
BSP location: |C:/Users/Public/Example_MPN/TARGET_MyBSP
Name Update Available  Remove | |y /s0¢/ip, CYBC6347BZI-BLD44 v
Devices
v Configurations 0 Device Info: Open CY8C6347BZI-BLD44 Documentation
Device Configurator 4.10 | Connectivity module:  None
Smart I/O Configurator 4.10 )
v Libraries . . .
catlemop x CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~
core-lib x Using HAL interface: CY_USING_HAL =
core-make p g
mtb-hal-cat1 p g
mtb-pdI-cat1 |
recipe-make-catia x
Components
Defines
Add Configuration...
Save Close
Ready
Add libraries - BSP Assistant 1.10 ><
EMW A A emwin
A
Name Shared Version SEGGER emWin
v Middleware embedded graphic
- library and graphical
emwin Latest 6.X release ~ i grap
user interface (GUI)
framework.
OK Cancel
Figure 25 Adding emwin to the list of libraries
20. After the necessary libraries are added, click on Save button for saving the BSP.
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C:/Users/Public/Example_MPN/TARGET_MyBSP - BSP Assistant 1.10

File Edit Settings View Help

BSP location: |C:/Users/Public/Example_MPN/TARGET_MyBSP
Name
v Configurations
Device Configurator 4.10

Smart /O Configurator 4.10
v Libraries

catlcmOp
core-lib
core-make
mtb-hal-cat1
mtb-pdl-cat1
recipe-make-catia
emwin

AR HHANRN

Components

Defines

Add Configuration... ' Add Library...

Ready

Update Available Remove .

MCU/SOC/SIP: CY8C6347BZI-BLD44 v

ﬂ Device Info: Open CY8C6347BZI-BLD44 Documentation

Connectivity module: None

CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~

Using HAL interface: CY_USING_HAL i

Figure 26 Saving the updated BSP
21. Click the Save button at the bottom to save the changes.
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Device Configurator 4.10
Smart /O Configurator 4.10
v Libraries

Connectivity module: None

catlcmOp
core-lib
core-make
emwin
mtb-hal-cat1
mth-ndl-cat1 i h

OO A

Add Configuration... ' Add Library...

x
A0
x
x
A
X
x
C:/Project/BSPappNote/BSPassistant/Hello_World/bsps/TARGET_MyBSP - BSP Assistant 1.10 - X
File Edit Settings View Help
BSP location: |C:/Project/BSPappNote/BSPassistant/Hello_World/bsps/TARGET_MyBSP
ilabl ~
Name Update Available - Remove MCU/SOC/SIP: CY8C6347BZI-BLD44 v
Devices
v Configurations 0 Device Info: Open CY8C6347BZI-BLD44 Documentation

CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~

Using HAL interface: CY_USING_HAL >

Save Close

Figure 27 Saving the BSP
22. Otherwise, there will be a warning as below while exiting the tool.

ki BSP Assistant 1.10 X

You have pending changes that have not been saved.
Do you really want to exit without saving them?

Yes Mo

Figure 28 Warning on missed BSP saving
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This completes the BSP creation; you can exit the tool now. If you changed any dependencies, you might
see the following warning while leaving the tool; you can ignore the warning since the BSP is not yet
being used in any applications.

BSP Assistant 1.10 %

| The libraries are modified. They must be updated in any applications that use
- this BSP either by using the Update feature of the Library manager or by
running make getlibs.

OK

Figure 29 Warning can be ignored

3.1.3 Create an application

With the BSP creation and configuration complete, create a Hello World application from a code example
template using the following steps.

1. Open Eclipse IDE for ModusToolbox™ from the Windows start menu and create a workspace as follows:
Eclipse IDE for ModusToolbox™ 3.1 Launcher X

Select a directory as workspace

Eclipse IDE for ModusToolbox™ 3.1 uses the workspace directory to store its preferences and development artifacts.

Workspace: | C\Project\BSPappNote\BSPassistant ~ Browse...

[ JiUse this as the default and do not ask again

» Recent Workspaces

Figure 30 Create Eclipse IDE workspace
2. Click File > New> ModusToolbox™ Application.
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BSPassistant - Eclipse IDE for ModusToolbox™ 3.1 - X
File Edit Navigate Search Project Run Window Help
New Alt+Shift+N > T9 Project... vt Q im|E
Open File... ™ Other.. CtrleN = 2 & Outline = o
C. Open Projects from File System... & ModusToolbox™ Application  Ctrl+7 There is no active editor that
Recent Files > provides an outline.
Close Editor Ctrl+W
Close All Editors Ctrl+Shift+W
Save Ctrl+S
Save As.
Save All Ctrl+Shift+S
Revert
Move.
Rename.. F2
Refresh F5
Convert Line Delimiters To >
Print... Ctrl+P
1 Import..
4 Export...
Properties Alt+Enter
Switch Workspace >
Restart
Exit
B Console % [£2 Problems O Memory & Terminal “BE#mByOv =D
ModusToolbox™ Console
\Log file(s) for this session are stored at: C:\Users\PALANI~1\AppData\Local\Temp\Logs15326603067686479663
Figure 31 Create new ModusToolbox™ application
The Project Creator tool opens on the Choose Board Support Package window.
Choose Board Support Package (BSP) - Project Creator 2.10 - O X
Settings Help
Source Template
Enter filter text... & || Create from MPN...| Browse for BSP...
~
Kit Name MCU/SOC/SIP Connectivity
AIROC™ Bluetooth® BSPs
AIROC™ Connectivity BSPs
PMG BSPs
PSoC™ 4 BSPs
PSoC™ 6 BSPs
TRAVEO™ BSPs
Wireless Charging BSPs
KMC™ BSPs
TITSmeEa |uau|r|g METITamTeEst udata (TUOUF TI15] ~
Loading the device db
Finished loading the device db (19604 ms)
INFO:Using the executable path for the tools directory.
0 error(s), 3 warning(s) ]
Next = Close

Figure 32 Project Creator tool
3. Select the BSP created in the previous section by clicking the Browse for BSP button and navigating to

the directory containing the previously created BSP and choosing it.
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Source Template

|Ens'f ter text... L || Create from MPN..‘IBrowse for BSP... IE
Kit Name MCU/SOC/SIP  Connectivity
AIROC™ Bluetooth® BSPs !
All - -
Select Folde X
PN Q
::z « v 1 » ThisPC *» Windows (C) * Users * Public > Example > TARGET_MyBSP ~ (] O Search TARGET_MyBSP
TR_ Organize ~ New folder = - 0
Wi
XN MTB3_1 ~ Name Date modified Type Size
Project COMPONENT_CMOP 12-04-2023 20:48 File folder
temp COMPONENT_CM4 12-04-2023 20:48 File folder
@ OneDrive - Person config 17-04-2023 14:36 File folder
deps 13-04-2023 00:31 File folder
W This PC docs 12-04-2023 20:48 File folder
¥ 3D Objects
| [ Desktop
| §
Loading [ Documents
Finished
INFOUs ¥ Downloads
| J" Music
| &= Pictures
| |0 error(s E Videos
b
c £ 3 Windows (C)
ol ¥ Network
Clereure
A4
Folder: | TARGET_MyBSP
Select Folder Cancel
Figure 33 Importing BSP

4, The BSP you selected is listed as shown. Select it and click Next >.
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Choose Board Support Package (BSP) - Project Creator 2.10
Settings Help

Source Template

(=

‘ Enter filter text...

Create from MPN...

Browse for BSP...

E &

~

Kit Name
AIROC™ Bluetooth® BSPs
AIROC™ Connectivity BSPs
Import
MyBSP
PMG BSPs
PSoC™ 4 BSPs
PSoC™ 6 BSPs
TRAVEO™ BSPs
Wireless Charging BSPs
XMC™ BSPs

MCU/SOC/SIP Connectivity

This is an imported BSP, located at C:/Users/Public/
Example/TARGET_MyBSP.

Summary:
BSP: MyBSP

Press "Next” to select application.

Next > Close

Figure 34

5.

Selecting imported BSP
On the Select Application page, select Hello World from the template application under Getting

Started. Enter a new name to the application such as Hello_World under the New Application Name
column as shown. After that, click Create.
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E Select Application - Project Creator 2.10

Settings Help

Application(s) Root Path: |C:/Users/Public/HelloWorld

Browse...

Target IDE: Eclipse IDE for ModusToolbox™

/7 | Browse for Application... ",’

W

Inello

Template Application Mew Application Name New BSP Name
v Getting Started
Hello World Hello_World MyBSP

v Peripherals
[ LZ4 compression and decompression demo

This code example
demaonstrates simple UART
communication by printing
a "Hello World" message
on a terminal and blinks an
LED using a Timer
resource.

For more details, see the
README on GitHub.

Surmmdary.

BSP: C:/Users/Public/Example/TARGET_MyBSP
Template Application(s): Hello World

Application(s) Root Path: C:/Users/Public/HelloWorld

Press "Create” to create the selected application(s).

< Back

Create Close

Figure 35 Select Application

The application download from GitHub starts and after successful completion, the project will be visible
in the Eclipse IDE Project Explorer as follows:

[ Example - Hello_World/README.md - Eclipse IDE for ModusToolbox™ 3.1

File Edit Navigate Search Project Run Window Help

i Br{vai | HvOvQvidS~ eI oo v mie
45 Debug !ili Registers 2 Periphe.. ~ O[5 README.md 2

HAL: Hello world

& Project ...

>

v & Hello_World

# Binaries
) Includes
v @& bsps This code example demonstrates a simple UART communication by printing the "Hello world"
v & TARGET_MyBSP message on a terminal and blinking an LED using a timer resource. The code example is based on
@ bluetooth HAL(Hardware Abstraction Layer) libraries.

& COMPONENT_CMOP

& COMPONENT_CM4 View this README on GitHub.

& confi ) .
& ;::,;g Provide feedback on this code example.
& docs
e i Requirements
n cybsp_hw_config.h v

< >

« ModusToolbox&trade; software v3.0 or later (tested with v3.0)

« Programming language: C

« Associated parts: All PSoC&trade: 6 MCU parts, XMC7000 MCU

* PSoC™ 6 board support package (BSP) minimum required version: 4.0.0 or XMC7200

| Quick Pa... - Variables ¢ Express.. % Breakp.. ~ O

Eclipse IDE for

- X
Q m|
= B|® 8 =0

8 Outline 52
~ v h1. HAL: Hello world
h2. Requirements
h2. Supported toolchains (m
h2. Supported kits (make vat
h2. Hardware setup
h2. Software setup
h2. Using the code example
h2. Provisioning steps (Only
h2. Operation
h2. Debugging
v h2. Design and implementat
h3. Resources and setting
h2. Related resources
h2. Other resources
h2. Document history

» Launches

» Tools

» BSP Configurators (MyBSP)

» Hello_World Library Configurators

» Hello World API Documentation

™ L it f - v
ModusToolbox evaluation kit BSP minimum required version: 1.0.0
» Start Markdown Source | Preview < >
» Hello World (MyBSP) © Console (2] Problems = Progress [ Memory & Terminal & Fleon EaBleEn®es0

B Hello_World ModusShell &2

Figure 36

Application note

New application in Eclipse IDE for ModusToolbox™

30

002-35297 Rev. *A
2023-06-09



o _.
Creating a ModusToolbox™ 3.x BSP In fl neon

3 Using the BSP Assistant tool

3.14 Code Build

1. Click Build Application in the Quick Panel pane as follows. If there are no errors, the build should pass

BSPassistant - Hello_World/README.md - Eclipse IDE for ModusToolbox™ 3.1 = X
File Edit Navigate Search Project Run Window Help
e BYRvaitvOovQvidsyvia v v v = Q iw| e
& Project .. & 1 Debug ¥ Registers % Peripher.. ~ = [ READMEmd & = B & Outline & =2§=0o
BSY § AV h1.HAL: Hello world A
& Hello World HAL: Hello world h2. Requirements
# Binaries h2. Supported toolchains
# Includes ) ) o - h2. Supported kits (make -
& bsps This code example demonstrates a simple UART communication by printing the "Hello world" h2. Hardware setup
& build message on a terminal and blinking an LED using a timer resource. The code example is based on ) h2. Software setup
& deps HAL(Hardware Abstraction Layer) libraries. h2. Using the code examp
& images Markdown Source  Preview < >
& libs 8 Console % [ Problems = Progress 0 Memory & Terminal te@lag-&lMayoy-o
< main.c CDT Build Console [Hello_World]
LICENSE Calculating memory consumption: CY8C6347BZI-BLD44 GCC_ARM A
» Makefile
& README.md T POT I PO
 mib_shared | Section Wene N Address 1S L !
2 KP.. ®-Variables 4 E .. % Break = | .cy_mep_image | exleeeeeee | 6540 |
Quid el pless) desine | .text | exleee2eee | 45224 |
. | .ARM.exidx | exleeedeas | 8 |
Eclipse IDE for | .copy.table | exieeedebe | 24 |
ModusToolbox™ | .zero.table | exieeedecg | 8 |
- | .data | exesee228c | 159 |
> Start | .cy_sharedmem | oxesee28cs | 12 |
- Hello World (MyBSP) | .noinit | exesee2sds | 228 |
| .bss | exesee20bc | 1864 |
& Build Application | .heap | exesee3les | 276216 |
¥ Clean Application | TTTTTTTITTTTTomsmmmmmssosssommmssooosommommooooees
Viaunches Total Internal Flash (Available) 1048576
Total Internal Flash (Utilized) 55072
» Tools
» BSP Configurators (MyBSP)
> Hello_World Library Configurators ©3:10:54 Build Finished. @ errors, @ warnings. (took 1m:23s.6@2ms)
» Hello_World AP Documentation .
< > < >

Figure 37 Successful build
This completes the use case demonstration.

3.2 Customizing an existing BSP

This use case happens when you want to make changes to an existing BSP. There are two cases:
«  Open and edit existing BSP on its own
« Open and edit an existing BSP from an application

3.2.1 Open and edit existing BSP on its own

The steps below show example updates to an existing BSP using the BSP created in the section Create and
configure the BSP using the existing sample board. These updates to the BSP are just for demonstration. The
user may perform updates depending on their application requirements. The following changes are made on
top of the previous BSP:

o Addthe freertos and retarget-io libraries

+ Add the corresponding component definition for the freertos library that was added in the above step
+ Adding a new macro to enable the conversion of LF to CR&LF in STDOUT while using retarget-io library
1. Open the BSP Assistant application. Click File > Open
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Untitled - BSP Assistant 1.10 X
File Edit Settings View Help

New [
= Open... Ctrl+O
e Export as ZIP file... Ctrl+E

Open in System Explorer...

Exit Alt+F4 To begin using BSP Assistant, you can

Open a BSP
Create a BSP based on a sample board
Create a BSP by specifying the MPNs it contains
Save Close
Open existing BSP.

Figure 38 Open existing BSP

To browse the directory containing the existing BSP, click Select Folder button to open the BSP in the
BSP Assistant application.

2.

&
[ select Directory Containing BSP x
« “ 4[> THEPC » Windows(C) > Users > Public » Example > TARGET.MyBSP > O Search TARGET_ M
Orgonize = Newfolder - e
L] Name ified Size
bluetooth
COMPONENT_ChOP
COMPONENT_Ch4
onfig
= pictures deps
ANzzEST! docs
docs 31
MTB3.1
sssssss hot
@ Oneive - e
= Tispe
3 30 Otject
1 Desktop
% Document
i —
b Music
= picures
B Videos
S Windows (C)
Folder;[TARGETMyB5P
SeectFolder Cancel
Save Close
Ready

Figure 39 Browse Existing BSP

The following window opens:
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C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10
File Edit Settings View Help

BSP location: |C:/Users/Public/Example/TARGET_MyBSP

Name Update Available Remove MCU/SOC/SIP: CY8C6347BZ1-BLD44 B
Devices
~ Configurations ﬂ Device Info: Open CY8C6347BZI-BLD44 Documentation

Device Configurator 4.10
Smart I/O Configurator 4.10
v Libraries

= Connectivity module: None

CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~
catlcmOp
core-lib
core-make A
emwin
mtb-hal-cat1
mth-ndl-cat1

Using HAL interface: CY_USING_HAL v

BHHN

Add Configuration... ' Add Library...

Loading BSP...

Finding the mtb-template-cat1 (release-v1.2.0) asset...

Finding the mtb-pdI-cat1 asset...

Finding MCUs compatible with this BSP...

mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (7 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (1 ms)

MCUs compatible with this BSP found (15 ms)

Save Close

Ready

Figure 40 BSP opened in BSP Assistant

3. Click the Add Library button and select the check boxes to add freertos and retarget-io libraries. Click

OK after selecting the libraries to add them to the BSP. You can use the filter box at the top of the window
to narrow down the list of libraries.
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BSP location: |C:/Users/Public/Example/TARGET_MyBSP

Name Update Available Remove hH

Devices Add libraries - BSP Assistant 1.10 X

v Configurations

Device Configurator 4.10 freertos VAR 4= freertos
Smart /O Configurator 4.10 =
v Libraries Name Shared Version " | AFreeRTOS is a foperties.
catlemOp v Bluetooth® small operating
core-lib O bluetooth-freertos O Latest 3.X release || system for

microcontrollers. A

core—-make v Core FreeRTOS kernel is
emwin & freertos Latest 10.X release distributed as
mtb-hal-cat1 O freertos-posix [E] Latest 1.X release + || standard C source
mth-ndl-cat1 files with
v Middleware configuration
Add Configuration... | Add Library... | O freertos-pkes11-psa O 80292d2 Release * | | header file. L
Loading BSP... (V Utilities > L. v B

Finding the mth-template-cat1 (release-v1.2.0) asset...

Finding the mtb-pdl-cat1 asset... Cancel
Finding MCUs compatible with this BSP...
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (7 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (1 ms)
MCUs compatible with this BSP found (15 ms) -
Save Close
Ready
&
BSP location: |C:/Users/Public/Example/TARGET_MyBSP
Name Update Available  Remove | | \jcy;/50c/sp, | cvac6347821-BLD44 v
Revices Add libraries - BSP Assistant 1.10 X

v Configurations £1-BLD44 Documentation

Device Configurator 4.10
Smart /O Configurator 4.10

Y = retarget-io

v Libraries Name Shared Version The Retarget 10 b —— e
catlemOp v Peripheral Ifibrary proyit'ies APIs fnage starts coreat Ly
core-lib retarget-io © Latest 1.X release - or transmitting SING_HAL -

messages to or from
core-make
freert the board via
reertos standard printf/scanf
mtb-hal-cat1 functions using a
mth-ndl-cat1 UART connection
Add Configuration... | Add Libral which is generally
connected to a host L
Loading BSP... machine. =

Finding the mth-template-cat1 (relea:
Finding the mtb-pdI-cat1 asset... Cancel
Finding MCUs compatible with this BS
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (7 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (1 ms)

MCUs compatible with this BSP found (15 ms)

Save Close
Ready
Figure 41 Adding libraries
4, To add a component, do the following;:
a. Click the Components section
b. Click Edit Additional Components...
c. In the Component to add field, enter FREERTOS
d. Click Add
e. If you do not have additional component to add, click OK
This closes the Edit Component window.
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BSP location: |C:/Users/Public/Example/TARGET_MyBSP
~| [T [T/ USETS/PUDIC/ CXATTPIE] TARGE T_VIyDSF/USP.TIK S
Name Update Available Remove
Components intrinsic to the MCU and/or connectivity MPNs

core-lib P4

core-make A p g BLESS-IPC, CAT1, CAT1A, PSOC6_01

freertos p g

mtb-hal-cat1 x Components specified via selections in the Devices section

mtb-pdl-cat1 | CMOP_SLEEP

recipe-make-catia A x

emwin x Additional components

retarget-io .4

= Components | 2
Defines | Edit Additional Components... .
Add Configuration...  Add Library... Edit Component - BSP Assistant 1.10 X
Loading BSP... 5
Finding the mtb-template-cat1 (release-v1.2.0) asset...
Finding the mtb-pdI-cat1 asset... 3. 4.
Finding MCUs compatible with this BSP...
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/r . H “
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4. Sombenentiiolaccy] FREERTOS | — I
MCUs compatible with this BSP found (15 ms)
Save IClvase
Ready
Figure 42 Add a component

5. To add a define, do the following:
a. Click the Defines section
b. Click Edit Additional Defines..

c. In the Define to add field, enter cy_RETARGET_IO_CONVERT_LF_TO_CRLF
d. Click Add
e. Since we have no additional defines to add, click OK

This closes the Edit Defines window.

5%

BSP location: |C:/Users/Public/Example/TARGET_MyBSP

Name Update Available Re;;ve File: |C:/Users/Public/Example/TARGET_MyBSP/bsp.mk

core-lib
Defines intrinsic to the MCU and/or connectivity MPNs
core-make A x
freertos x
mtb-hal-cat1 x
mtb-pdl-cat1 ) Defines specified via selections in the Devices section
recipe-make-cat1a A x CY USING HAL
emwin P4
retarget-io x Additional defines
Components
" | Defines | 2.
m Edit Additional Defines... N

Add Configuration... ' Add Library...

Loading BSP... *| &4 edit Define - BSP Assistant 1.10 X &
Finding the mtb-template-cat1 (release-v1.2.0) asset...
Finding the mtb-pdI-cat1 asset...

Finding MCUs compatible with this BSP... 3, 2
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-c

mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-| . ﬁ
MCUs compatible with this BSP found (15 ms) Define to addk )_ CONVERT_LF_TO_CRL| Add

5
oK Cancel b Close

Ready
E A Ssearch i J P 3 A~ wmd) T P N 1713 B

Figure 43 Add a define
6. Click the Save button to save the changes.
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C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10 — X
File Edit Settings View Help

BSP location: |C:/Users/Public/Example/TARGET_MyBSP

Name Update Available  Remove | ) sy /gip. CY8C6347BZI-BLD44 v
core-lib

core-make A
freertos

mtb-hal-cat1

mtb-pdl-cat1

recipe-make-catia A
emwin

ﬂ Device Info: Open CY8C6347BZI-BLD44 Documentation

Connectivity module: None

CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~

Using HAL interface: CY_USING_HAL v
retarget-io

DO AHHN

Components

Defines

Add Configuration... ' Add Library...

Loading BSP... 5
Finding the mtb-template-cat1 (release-v1.2.0) asset...

Finding the mtb-pdI-cat1 asset...

Finding MCUs compatible with this BSP...

mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (7 ms)

mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (1 ms)

MCUs compatible with this BSP found (15 ms)

Close
Ready
Figure 44 Save updated BSP
A Saving changes to BSP succeeded. message shows in the console window.
C:/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10 - X
File Edit Settings View Help
BSP location: |C:/Users/Public/Example/TARGET_MyBSP
Name Update Avallable  Remove | ycy/s0¢/5ip: CY8C6347BZI-BLD44 .
core-lib x
core-make A x 0 Device Info: Open CY8C6347BZI-BLD44 Documentation
freertos x @ - dule: |IN
mtbfhalfcatll x onnectivity module: one
mtb-pdl-cat1 )
recipe-make-cat1a A x CMO+ pre-built firmware image: | This image starts CM4 core at CY_COR ~
emwin x Using HAL interface: CY_USING_HAL -
retarget-io x
Components
Defines
Add Configuration... ' Add Library...
Hndlng the mtb—pdl—caﬂ asset... ~
Finding MCUs compatible with this BSP...
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (7 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (1 ms)
MCUs compatible with this BSP found (15 ms)
Saving changes...
[Saving changes to BSP succeeded. | =
Save Close
Ready
Figure 45 Save message

7. Click the Close button to close the BSP Assistant. While exiting, a warning is displayed to update the
application using the library manager. This warning can be ignored as we are yet to create an application
from this BSP.
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{5 C/Users/Public/Example/TARGET_MyBSP - BSP Assistant 1.10 — X
File Edit Settings View Help

BSP location: |C:/Users/Public/Example/TARGET_MyBSP
~| [T [T/ USETS/PUDIC/ EXATTPIE] TARGE _VIyDSF/USP.TIK
Name Update Available Remove
X Defines intrinsic to the MCU and/or connectivity MPNs
Devices

v Configurations

Device Configurator 4.10

Smart I/O Configurator 4.10 |
v Libraries CY_USING_HAL

Defines specified via selections in the Devices section

catlcmOp x . X

core-lib x Additional defines

core-make A x CY_RETARGET_IO_CONVERT_LF_TO_CRLF
emwin x Edit Additional Defines...

freertos x

mth-hal-cat1 x

Add Configuration... ' Add Library...

Finding the mtb-pdi-catT asset..

Finding MCUs compatible with this BSP...

mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (11 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (6 ms)

MCUs compatible with this BSP found (15 ms)

Saving changes...

Saving changes to BSP succeeded.

Save Close

Ready
BSP Assistant 1.10 X
| The libraries are modified. They must be updated in any applications that use
. this BSP either by using the Update feature of the Library manager or by
running make getlibs.
OK
Figure 46 Library update warning
3.2.2 Open and edit an existing BSP from an application

The steps below show an example update to the BSP that is already part of an application. The application that
was created in the Create an application section will be used as the starting point. These updates to the BSP
are just for demonstration purposes. The user may choose updates depending on his/her updated application
requirements.

The following changes are made on top of the previous BSP:

« Add the freertos library

+ Add the corresponding component definition for the freertos library that was added in the above step

+ Add a new macro to enable the conversion of LF to CR&LF in STDOUT while using the retarget-io library

1. Open the Eclipse IDE for ModusToolbox™ from the Windows start menu. Click Browse to browse the
previously created workspace directory containing the application and then click the Launch button.
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E Eclipse IDE for ModusToolbox™ 3.1 Launcher X

Select a directory as workspace

Eclipse IDE for ModusToolbox™ 3.1 uses the workspace directory to store its preferences and development artifacts.

Workspace: ’C:\Users\Puinc\Example V‘ E Browse... ;

[[] Use this as the default and do not ask again
» Recent Workspaces

Launch Cancel

Figure 47 Open an application in Eclipse IDE

2. When the application finishes loading in the Eclipse IDE, you can run the BSP Assistant tool by clicking
the BSP Assistant <version> link in the Quick Panel as shown.

s Example - Edlipse IDE for ModusToolbox™ 3.1 = X
File Edit Navigate Search Project Run Window Help
(e ®S-{-@Bd X > O "Q ™ P~ - vt ' - v |2 g Q m||E
[ Project Explorer 53 45 Debug Lili Registers 2. Peripherals = O [¥ READMEmd 5% = B g Outline 3 =0
v 125 Hello_World ~ HAL: Hello world A+ hi. HAL: Hello world
4, Binaries h2. Requirements
&l Includes X i - h2. Supported toolchair
@ bsps This code example demonstrates a simple UART communication by printing the "Hello h2. Supported kits (mak
= build world" message on a terminal and blinking an LED using a timer resource. The code h2. Hardware setup
& deps example is based on HAL(Hardware Abstraction Layer) libraries h2. Software setup
(= images h2. Using the code exan
& libs View this README on GitHub. h. Provisioning steps ({

[ main.c h2. Operation
D 1ICENSE v Provide feedback on this code example h2. Debugging
[ Quick Panel (%= Variables &' Expressions 9 Breakpoints = ia v h2. Design and impleme
! - h3. Resources and se
Eclipse IDE for ~ Requirements h2. Related resources
ModusToolbox™ h2. Other resources
h2. D t hist
+ ModusToolbox&trade: software v3.0 or later (tested with v3.0) S
» Start * Programming language: C
» Hello_World (MyBSP) « Associated parts: All PSoC&trade; 6 MCU parts, XMC7000 MCU v
- e NCANTM 8 haned ~riinnart nackana IDCD) minimiimn ramiira, A vineninn ANNAr
» Launches >
— Markdown Source | Preview < >
~ Tools
B Console [£] Problems = Progress [J Memory & Terminal 2 S| © 41| Iz G BB =0

[ Device Firmware Update Host Tool 2.0 5 Hiello World ModusShell 5¢

[ Library Manager 2.10 ala
3

» BSP Configurators (MyBSP)

» Hielio Worid Library Configurators

» Hello World APl Documentation X
<

Figure 48 Launching BSP Assistant
3. Click the Add Library button to add the freertos library. Click OK after selecting the library to add the
library to the BSP.
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BSP location: |C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP

Name Update Available Remove MCU/SOC/SIP: CY8C6347BZI-BLDA4 -
Devices
« Configurations ﬂ Device Info: Open CYBC6347BZI-BLD44 Documentation

Device Configurator 4.10 | Connectivity module:  None

Smart I/O Configurator 4.10 1 |
v Libraries [ Add libraries - BSP Assistant 1.10 X

4 core at CY_COR

<

cat1lcmOp _ ——
core-lib AR 4= freertos .
core-make - N 5 .
. Name Shared Version A FreeRTOS is a
emwin ,
mitb-hal-cat1 © Bluetooth® small o;:eratmg
system for
-ndl- O bluetooth-freert o ¥ .
mth-ndl-cat1 uetooth-freertos Latest 3.X release microcontrollers.
Add Configuration... | Add Library... v Core A FreeRTOS kernel
& freertos =] Latest 10.X release is distributed as L
Loading BSP... O freertos-posix o Latest 1.X release standard C source 2
Finding the mtb-template-cat1 (release-v1.2.0) asset... . files with
- ¥ Middleware X .
Finding the mtb-pdI-cat1 asset... v| | configuration
Finding MCUs compatible with this BSP... < = =

mtb-template-cat1 asset found at C:/Users/palaniswamy/.
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modu
MCUs compatible with this BSP found (14 ms)

Save Close

E £ Search gi J = 2 ) T £ NG 1822 BR

Figure 49 Add Library
4, To add a component, do the following:

a. Click the Components section

b. Click Edit Additional Components...

c. In the Component to add field, enter FREERTOS

d. Click Add

e. If you do not have additional component to add, click OK
This closes the Edit Component window.

BSP location: |C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP
Name Update Available . Remove File: | C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP/bsp.mk
catlcmOp x o " " .
core-lib x Components intrinsic to the MCU and/or connectivity MPNs
core-make A > BLESS-IPC, CAT1, CAT1A, PSOC6_01
freertos P g
mtb-hal-cat1 x Components specified via selections in the Devices section
mtb-pdl-catt il CMOP_SLEEP
recipe-make-catia 1 A x
emwin .4 Additional components
Components |
Defines
| Edit Additional Components... .
Add Configuration... ' Add Library... {8 Edit Component - BSP Assistant 1.10 X L
Loading BSP... | E—
Finding the mtb-template-cat1 (release-v1.2.0) asset... 3 4.
Finding the mtb-pdI-cat1 asset...
Finding MCUs compatible with this BSP... e - dd‘l ‘ FREERTOS H | Add I
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1 omponent to addy
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3. Cancel
MCUs compatible with this BSP found (14 ms) -
Save Close
E P search i J P : ~ wm ) T £ NG 1825 B

Figure 50 Add a component
5. To add a define, do the following:

a. Click the Defines section
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b. Click Edit Additional Defines..

c. In the Define to add field, enter cy_RETARGET IO _CONVERT _LF_TO_CRLF
d. Click Add

e. Since we have no additional defines to add, click OK

This closes the Edit Defines window.

e

BSP location: |C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP

Name Update Available ~ Remove File: | C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP/bsp.mk
catlcmOp x
" Defines intrinsic to the MCU and/or connectivity MPNs
core-lib p. g
core-make A P4
freertos P g
mtb-hal-cat1 x Defines specified via selections in the Devices section
mtb-pdl-cat1 | CY_USING_HAL
recipe-make-catia A x
emwin N x Additional defines
Components )
| Defines | 2
- Edit Additional Defines... .
Add Configuration... 'Add Library... Edit Define - BSP Assistant 1.10 X
Loading BSP... b 7

Finding the mth-template-cat1 (release-v1.2.0) asset...
Finding the mtb-pdI-cat1 asset...

Finding MCUs compatible with this BSP... §
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-caf Define to add: ‘CY,RETARGET,IO,CONV Add

mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-\
MCUs compatible with this BSP found (14 ms)

3, 4.

Cancel

S. Save Close

E P search i J s . 7 NG 1820 B

Figure 51 Add a define
6. Click the Save button to save the changes.

C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP - BSP Assistant 1.10 - X
File Edit Settings View Help

BSP location: |C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP

~| [T [T/ USETS/PUDIC/ CXETTPIE/ MENU_VVOT G/ OSPS/ TARGE T_ViyDSF/OSPITK | A

Name Update Available Remove
Devi Defines intrinsic to the MCU and/or connectivity MPNs
evices

v Configurations
Device Configurator 4.10
Smart /O Configurator 4.10

Defines specified via selections in the Devices section

v Libraries CY_USING_HAL
cat1cmOp P g - )
core-lib x Additional defines
core-make A > CY_RETARGET_IO_CONVERT _LF_TO_CRLF
freert:
reertos x Edit Additional Defines...
mtb-hal-cat1 x
mth-ndl-cat1 3 . .

Add Configuration... ' Add Library...

Loading BSP... 5
Finding the mtb-template-cat1 (release-v1.2.0) asset...

Finding the mtb-pdI-cat1 asset...

Finding MCUs compatible with this BSP...

mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (14 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (6 ms)

MCUs compatible with this BSP found (14 ms)

Close

Figure 52 Save Updated BSP

A Saving changes to BSP succeeded. message shows in the console window.
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C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP - BSP Assistant 1.10 — X
File Edit Settings View Help
BSP location: |C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP
~| [T [T/ USETS/PUDIIC/ CXETTPIE/ MENOU_VWOT G/ OSPS/ TRARGE T_VIyBSF/OSPITK | A
Name Update Available Remove
X Defines intrinsic to the MCU and/or connectivity MPNs
Devices
v Configurations
Device Configurator 4.10
9 . - Defines specified via selections in the Devices section
Smart I/O Configurator 4.10 )
v Libraries CY_USING_HAL
catTemO)
P x Additional defines
core-lib P g
core-make A x CY_RETARGET_IO_CONVERT_LF_TO_CRLF
freerts
reertos x Edit Additional Defines...
mtb-hal-cat1 x
mth-ndl-cat1 al v v
Add Configuration... ' Add Library...
Finding the mtb-pdi-catT asset.. B
Finding MCUs compatible with this BSP...
mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (14 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (6 ms)
MCUs compatible with this BSP found (14 ms)
Saving changes...
[Saving changes to BSP succeeded. ] -
Save Close

Figure 53

Save message

7. Click the Close button to close the BSP Assistant. While exiting, a warning is displayed to update the
application using the library manager. You can run library manager after closing the BSP Assistant tool.

C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP - BSP Assistant 1.10 — x

File Edit Settings View Help

BSP location: |C:/Users/Public/Example/Hello_World/bsps/TARGET_MyBSP

| [ FIE: [T/ USETS/ PUDIIC/ EX@NTPIE/ FIENo_VVOTTa7 0SPS/ TARGE T_IVIyBSF70SPITK |«
Name Update Available Remove
. Defines intrinsic to the MCU and/or connectivity MPNs
Devices

v Configurations
Device Configurator 4.10
Smart /O Configurator 4.10
v Libraries

Defines specified via selections in the Devices section

CY_USING_HAL

catlcmOp
. Additional defines
core-lib

core-make A CY_RETARGET_IO_CONVERT_LF_TO_CRLF
freertos
mtb-hal-cat1

mtb-ndl-cat1 ] Y o

Edit Additional Defines...

2 AN

Add Configuration... 'Add Library...

Finding the mtb-pdi-cat asset... -
Finding MCUs compatible with this BSP...

mtb-template-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-template-cat1/release-v1.2.0 (14 ms)
mtb-pdl-cat1 asset found at C:/Users/palaniswamy/.modustoolbox/global/mtb-pdI-cat1/release-v3.4.0 (6 ms)

MCUs compatible with this BSP found (14 ms)

Saving changes...

Saving changes to BSP succeeded.

BSP Assistant 1.10 %

The libraries are modified. They must be updated in any applications that use
. this BSP either by using the Update feature of the Library manager or by
running make getlibs.

oK
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Figure 54

Library update warning
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8. Click the Library Manager link in the Quick Panel.

s Example - Edlipse IDE for ModusToolbox™ 3.1 - X
File Edit Navigate Search Project Run Window Help
{52 Qw80 O~ Q™ ~ v vt vo v Q m
C5 Project Explorer 53 4 Debug i Registers 7, Peripherals = O [¥ READMEmd 3 = O g Outline 3 =0
v 5 Hello_World ~ HAL: Hello world A\ RTEAE o wond
4% Binaries h2. Requirements
i) Includes : h2. Supported toolchair
& bsps This code example demonstrates a simple UART communication by printing the "Hello h2. Supported kits (mak
~. build world" message on a terminal and blinking an LED using a timer resource. The code h2. Hardware setup
= deps example is based on HAL(Hardware Abstraction Layer) libraries. h2. Software setup
(= images h2. Using the code exan
& libs View this README on GitHub. h2. Provisioning steps (¢
4 main.c h2. Operation
= | ICENSE v Provide feedback on this code example h2. D:buggmg
[ Quick Panel (x)= Variables &' Expressions 9 Breakpoints = - v h2. Design and implem¢
H h3. Resources and se
» Start A Req uirements h2. Related resources

h2. Other resources
h2. Document history

» Hello_World (MyBSP)

S + ModusToolbox&trade; software v3.0 or later (tested with v3.0)
» Programming language: C
Y. T « Associated parts: All PSoC&trade: 6 MCU parts, XMC7000 MCU v
@ B5P Assistant 110 CislSiaanase e S T T W e e ey T T R W .
& Device Fin e Update Host Tool 2.0 Markdown Source | Preview < >

B Console [£] Problems &g Progress [J Memory @ Terminal 52 5| 2 I5 e BB &=0
» BSP Configurators (MyBSP) & Hello_World ModusShell 53
+ Hello_World Library Configurators NPT

(& Bluetooth® Configurator 2.80 (new configuration g
[ LIN Configurator 1.21 (new configuration
Hello_World APl Documentation v
< >
&5 Hello_World
Figure 55 Launch Library Manager
9. On the Library Manager window, click the Update button.

Library Manager 2.10 — X
Settings  Help Restore Down|
Application Directory: C:/Users/Public/Example/Hello_World Browse...

Enter filter text... & | 1= Properties Description

Name Update Available Remove a Property Value

v BSPs Name freertos
© MyBSP (ACTIVE) .

v Hello_World Libraries Version 10.4.306 release 2
abstraction-rtos | i
catlemOp = Type Shared Git Repo 2
clib—‘support | Location C:/Users/Public/Example/mtb_shared/freertos/release-v10.4.306
cmsis i
core-lib ) Source https://gitlab.intra.infineon.com/repo-staging/freertos
core-make A | ) . . .
emwin 5 *mtb file location C:/Users/Public/Example/Hello_World/libs/freertos.mtb
freertos | v

Add BSP Add Library

Click "Update" to commit the changes

0 error(s), 9 warning(s)

Successfully acquired the information. v

Figure 56 Update libraries

When the library updates complete, the message Successfully Updated Application shows in the

console.
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Library Manager 2.10 — X

Settings  Help

Application Directory: C:/Users/Public/Example/Hello_World Browse...
Enter filter text. & 1= Properties README.md Description
Name Update Available Remove . Property Value )
¥ BSP.
s Name freertos
© MyBSP (ACTIVE) )
¥ Hello_World Libraries Version 10.4.306 release ©
abstraction-rtos | )
catlcmOp y Type Shared Git Repo N
clib-support i Location C:/Users/Public/Example/mtb_shared/freertos/release-...
cmsis |
core-lib | Source https://gitlab.intra.infineon.com/repo-staging/freertos .
coreimake A :f‘ Reference Documentation:
emwin _ FreeRTOS: FreeRTOS for Infineon MCUs - Overview
freertos | o

Add BSP Add Library

Summary:

Successfully updated application "Hello_World"
Successfully refreshed dependencies.

Done. -

Update Close

Figure 57 Library Manager update status
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ModusToolbox™ BSPs that are either custom to a user application or preconfigured made available in GitHub
can belong to different generations. You can find out the generation the BSP through the following:

Table 3 BSP generations

BSP root directory contains the | BSP Generation
file

version.xml and not props.json 3

props.json and not version.xml 4

The BSP Assistant is only available for generation 4 BSPs using ModusToolbox™ version 3.0 or later.

Please note that BSP generation and BSP version have different meaning and should not be used
interchangeably.

4.1 Differences between ModusToolbox™ BSP generations

BSP generation tools version 3 and 4 differ in the following ways:

Table 4 BSP generation 3 and 4 differences

Property BSP generation 3 BSP generation 4

BSP configuration directory COMPONENT_BSP_DESIGN_MODUS Config

name

BSP build toolchain linker file <platform>_<cpu>.sct for Arm® linker.sct for Arm®

name <platform>_<cpu>.1d for GCC linker.1ld for GCC
<platform>_<cpu>.icf for IAR linker.icf for IAR

BSP version information version tag in version.xml file in the |version field in props. json file in the
BSP root directory BSP root directory

BSP makefile name <bsp_name>.mk bsp.mk

BSP locate_receipe.mk file Present Not present

Further, the contents of the Makefile differs significantly between the generations and the below figure shows a
sample comparison:
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Q) CY8CPROTO-062-4343W.mk <—> bsp.mk - Text Compare - Beyond Compare e m] X
Session File Edit Search View Tools Help New version available...
@ @ | = # = = ~ a2 B | » 4 ¢
Home Sessions All Diffs Same | Context Minor | Rules Format | Copy Edit Next Section Prev Section | Swap Reload
C:\.\TARGET_CY8CPROTO-062-4343W-latest-v3.X\CYBCPROTO-062-4343W.mk v l =~ ‘C‘\.v \TARGET_CY8CPROTO-062-4343W-latest-v4.X\bsp.mk v =~
== 29-03-2022 10:32:44 2,199 bytes Everything Eilse ¥ ANSI ¥ UNIX 30-05-2023 23:38:24 2,740 bytes Everything Else ¥ ANSI ¥ UNIX
b E- l A~ | | 46 MPN_LIST:=CYBC624ABZI-S2D44 - BEESKL1DXY ()
T 38 DEVICE:=CY8C624ABZI-S2D44" 7 DEVICE:=CY8C624ABZI-S2D44

#+Additional-devices-on-the:boardy =
#+=--If-you:change-the-additional-device-here-you-must-also-update-the-design
1 ==the-device-configurator.-You-may-also-need-to-update-the-COMPONENT -varia

42 #----correct-Wi-Fi-and-Bluetooth-firmware.9 L

43 ADDITIONAL_DEVICES:=CYW4343WKUBG ADDITIONAL_DEVICES:=CYWA343WKUBG
44 #:Default-target-core-to:CM4:if-not-already-set9 &a

45 CORE?=CM49

46 #-Basic-architecture-specific:components9

47 COMPONENTS+=$ (TARGET) -CAT1-CAT1AY

3
19 ifeq=($(CORE),CM4)9
50 #+Additional:components:supported-by+the+target9y
51 COMPONENTS+=CMOP_SLEEP-BSP_DESIGN_MODUS - PSOC6HAL - 4343W- MURATA-1DX- HCI -UART' [ E INENTS : =4343W-CAT1- CAT1A -HCI-UART - MURATA-1DX-PSOC6_02
52 #:Use-CyHAL S2D44_CORES: =CORE_NAME_CM@P_0-CORE_NAME_CM4_0
-52D44 _DIE:=PSoC6A2MY

FEATURES : =NAY

0489
249

53 DEFINES+=CY_USING_HAL
54 endif
(UBGY

irator s capsense-configurator

47:33 < > < >
=>COMPONENTS+=% (TARGET) * CAT1:CAT1AY

# 6 difference section(s) Important Left Orphan Insert Load time: 0.11 seconds

Figure 58 BSP Makefile Differences

4.2

Migrating the ModusToolbox™ BSP

ModusToolbox™ custom BSPs generated through version 2.x tools can be migrated to version 3.x tools using
one of the following two methods so that the user application can take advantage of the latest features of the
ModusToolbox™ ecosystem.

4.2.1 Using the BSP Assistant tool

1. Create a new BSP with the BSP Assistant tool by following the steps described in the Creating a new BSP
section of this document.

2, Update the following files in the newly created custom BSP with the settings from the corresponding
version 2.x files:
«  BSP configuration files including design.modus, etc.
+  BSP linker files
+ Add any other dependencies for the BSP other than the default dependencies by using the Add

Library button in the BSP Assistant tool

3. Import the newly created custom BSP into your ModusToolbox™ application by running the Library
Manager tool in your ModusToolbox™ application directory by clicking Add BSP and then clicking
Browse on the Add or Import BSP dialog as follows:
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& Lib 2 — O
| ﬁ Add B L er2
Appl  Source Template | Browse...
Entg |Ente|‘ filter text... i || |Create from MPN...l Browse for BSP... | =
| 1 |
Kit M
ame [ Select Folder *
v AIROC™ Bluetooth
J ‘;ll\igCBSPEDHHECtI « v A4 <« Users » Public » Example » Search Example
P5oC™ 4B5Ps
PSaC™ 6 BSPs Organize » New folder = v o
TRAVEQ™ BSPs ~ ’
. MName Type
Wireless Charging & This PC e
KMC™ BSPs _J 3D Objects mitw_3.1 File fol
I Desktop TARGET_MyBSP File fol
= TARGET_5-24-23 File fol
Destination |=| Documents .
* o load TARGET_3-17-23 File fol
Parent directory: ownoads TARGET_MyBSP-5-4-23 File fol
L NewBSPname TarGy & M€
Al | Pictures
B videos
Star =5 wr 2
Refresnea an aepenaencies tor| = JULEETSGeY wlle =
0 error(s), 0 warning(s)
Successfully acquired the inforl Folder: | TARGET_MyBSP v
Select Folder Cancel jose
Figure 59 Browsing to the BSP folder Caption
4, Make the new BSP active and click Update.
[ Library Manager 2.10 — O X
Settings  Help
Application Directory: |C:/Users/Public/Example/mtw_3.1/Hello_World Browse...
Enter filter text... ,_,,_| =
MName Update Available Remove
v BSPs
£253-4343W >
1
v Hello_World Libranes
catlemip g
cmsis ™
core-lib |
core-make g
ermwin g
mitb-hal-catl g
mtb-pdl-catl i
recipe-make-catla =
retarget-io >
Add BSP Add Library
Changelog for project "Hello_World™: ()
CY8CPROTO-06253-4343W version release-v4.1.0 added (APP_CY8CPROTO-06253-4343W)
Click "Update" te commit the changes v
Update Close

infineon

4.2.2

Application note

Figure 60

Selecting the BSP Caption
This completes the migration of the BSP from version 2.x to 3.x using the BSP Assistant tool.

Without using the BSP Assistant tool

1. Delete the version.xml file.
2, Delete the deps directory.
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3. Create a new file called props.json and add the various properties by looking into a similar file from
preconfigured 3.x BSPs in GitHub.

4, Rename the BSP configuration directory COMPONENT_BSP_DESIGN_MODUS to config.
5. Rename the BSP makefile <bsp_name>.mk to bsp.mk.

6. Update the bsp.mk file by comparing with an existing 3.x format bsp.mk file because there are significant
changes between the 2 generations.

7. Rename the linker files in the directory COMPONENT_cMeP and COMPONENT_CM4 as follows:
. <platform>_<cpu>.sct to linker.sct for Arm®
o <platform>_<cpu>.1ld to linker.1d for GCC
o <platform>_<cpu>.icfto linker.icf for IAR
8. Delete the locate_recipe.mk file.
9. Follow the steps in Create an application to import the new BSP to the application.
This completes the migration of the BSP from version 2.x to 3.x without using the BSP Assistant tool.
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